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Document summary
This document is an Administration Guide that is intended for system administrators who will install and
manage Application Service Management ( ASM) on their network. This document provides the technical
instructions and the required data to carry out the installation and configuration. To perform the installation,
you need knowledge of your operating system and network configuration. In addition, you must have
the basic skills to install software on server and client. This document also includes all the information
you must have to administer the ASM.

Comments?
We continually review and improve our documentation. Any remarks/requests for information concerning
this document or topic are appreciated. Please e-mail your comments to documentation@infor.com .

In your e-mail, refer to the document number and title. More specific information will enable us to process
feedback efficiently.

Contacting Infor
If you have questions about Infor products, go to the Infor Xtreme Support portal at www.infor.com/
inforxtreme .

If we update this document after the product release, we will post the new version on this Web site. We
recommend that you check this Web site periodically for updated documentation.
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This chapter provides a brief introduction to the ASM

The Application Service Manager ( ASM) is an administrative tool that you can use to start and stop LN
or other (partner) application services. You can predefine the application services that the ASM can
start or stop in files in .XML format. An application service that you define with the ASM is called an
instance.

Note

ASM supports several types of instances. Some instances must be ASM-aware. For example, the
Multiple type must have an integration with the ASM.

You can run ASM on these platforms:

▪ Windows
▪ UNIX

For a complete overview of the supported hardware platforms for ASM, see Appendix E in this document.

The procedure to install and configure ASM:

1. Install ASM.
2. Configure the ASM server.

Infor ES Application Service Manager | Administration Guide | 7
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Definitions, acronyms, and abbreviations

DefinitionTerm

Application Programming InterfaceAPI

The ASM installation/home directory<home directory >

Application Service ManagementASM

The ASM engine that handles start and stop re-
quests and management requests

ASM Server

A graphical user interface for managing the ASM
that runs as a snap-in in the MMC (Windows only)

ASM Snap-in

LN software environmentBSE

Command promptCMD

Graphical User InterfaceGUI

Dynamic Link Library: A library of executable
functions or data for use by aWindows application.

DLL

Domain Name ServerDNS

Microsoft Management ConsoleMMC

eXtensible Markup LanguageXML

User interfaceUI

Installable UnitIU

A Windows environment variable.%variable%

A UNIX environment variable${BSE}
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This chapter describes the installation process of the ASM server.

Installing the ASM Server
The ASM Server consists of the ASM Server and a client command line interface, (asm_cli). For more
information about the command line interface, see Management from command line (p. 31) .

Several graphical user interface-based utilities are available to configure and manage the ASM Server.
These utilities are called the ASM configuration (UI) utilities, and run as a snap-in on the Microsoft
Management Console (MMC). For information on how to use these utilities, see “Configure services
and instances”. The common line interface of ASM provides functionality similar to the MMC snap in,
AsmSnapin.

Note

To use the ASM Server, you must start the server, as discussed in Starting the ASM server (p. 15) ,
and then configure the server after installation, as described in Configuring services and instances
(p. 21) .

ASM software components
These tables list all the ASM software components for Windows and UNIX environments:

Windows Files and Directories

<home directory > Points to the ASM installation directory

C:\Infor\ERPLN\ASMDefault installation directory of ASM Server components

Infor ES Application Service Manager | Administration Guide | 9
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<home directory >\bin\asm_srv.exeASM Server

<home directory>\bin\asm_cli.exe

<home directory >\bin\baanmsg.dll

<home directory >\bin\benttool.dll

<home directory >\bin\rexeccfg.dll

<home directory >\shlib\TssConvert.dll

+ similar named files with .pdb extension

<home directory >\lib\*xml.sampleASM Server sample configuration files

< home directory >\bin\AsmSnapin.dllDefault installation directory for ASM MMC snap-in DLLs

< home directory >\bin\AsmCfgSnapin.dll

< home directory >\bin\Asm.msc

+ similar named files with .pdb extension

10 | Infor ES Application Service Manager | Administration Guide

Installing ASM



UNIX Files and Directories

<home directory > Points to the ASM installation directory

/opt/Infor/ERPLN/ASMDefault installation directory

<home directory >\bin\asm_srvASM Server

<home directory >\bin\asm_cli

<home directory >\shlib\TssConvert.<ext>

where <ext> is OS dependent

<home directory >\etc\rc.startasmASM Server sample start/stop scripts

<home directory >\etc\rc.stopasm

<home directory >\lib\*xml.sampleASM Server sample configuration files

Installation of ASM server (Remote)
This section is for UNIX installations only.

With the ASM Installation Wizard, you can install the software on computers that operate on various
platforms, such as Windows and UNIX. You can find this installation program in the setup folder. The
installation program only runs on Windows.

To remotely install the ASM software, take these steps:

1. Double-click the Setup.exe file in the setup folder to start the setup program manually. The
Welcome dialog box appears, which tells you that ASM will be installed. It is recommended
to close all other programs.

2. Click Next to continue with the Location dialog box. In the Location dialog box.
3. Specify whether you want to install the software locally, on the computer where you run the

ASM Installation Wizard, or on a computer in your network, a remote computer. In this
procedure, you will install the software remotely.

4. Click Remote and click Next. The Host Name dialog box appears.

5. Specify the host computer on which the ASM software will be installed. The dialog box contains
fields for the DNS name of this computer, the Host Name, and for a user name to gain access
to this computer, the Login Name.
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Select the checkbox: Use SFTP and SSH-2 for connecting to host when you want to use
the secure protocol. Note that the host [or host account] must be configured to support this.
Secure ftp is implemented by means of the SSH File Transfer Protocol (SFTP) over SSH
protocol version 2 (SSH-2). Secure rexec is also implemented by means of SSH-2.

6. Click Next. The Platform Type dialog box appears.
Every platform uses a different LN porting set. This dialog box helps you to determine which
porting set you must use. The installation wizard detects on which platform type you want to
install the ASM software. One or more platform types that are suitable for your machine can
be presented.

7. Select the platform type and click Next. The Destination Directory dialog box appears.
Specify the path and the name of the directory in the Destination Directory field. To this
directory you will copy the ASM software. This so-called installation directory, or home directory,
of the ASM represents the root directory for all ASM software that you will install during this
installation session.

8. Click Next. The Installation Components dialog box appears. Specify which components
you want to install. The ASM Installation Wizard installs those components that you select.
The other two options with snap-in are unavailable because these options cannot be installed
on non-Microsoft platforms.

9. The Ready to Install dialog box is displayed, which provides a summary of the installation
settings. Check whether the settings are correct.

10. Click Install to start the installation of the ASM software to the specified directory on the
selected computer.

11. When the installation has finished, click Finish to complete the ASM Server installation.

Installation of ASM server (Local)

Windows only

To install the ASM software locally, take these steps:

1. Double-click the Setup.exe file in the setup folder to start the set-up program manually. The
Welcome dialog box appears, which tells you that ASM will be installed, that you are
recommended to close all other programs.

2. Read this information and click Next. The Location dialog box appears. In this dialog box,
you specify whether you want to install the software locally, on the computer where you run
the ASM Installation Wizard, or on a computer in your network, a remote computer. In this
procedure, you will install the software locally.

3. Click Local and click Next. The Host Name dialog box appears. The Host Name and the
Login Code fields are already filled.

4. Click Next. The Destination Directory dialog box appears
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5. Click Browse to specify the path and the name of the directory in the Destination Directory
field, or click Next to accept the default directory.
The ASM software will be copied to this directory. This so-called installation directory, or home
directory, of the ASM represents the root directory for all ASM software that you will install
during this installation session.
Note that you cannot run more than one ASM Server on Windows. If the ASM software is
already installed and found during installation, the ASM software components will be updated.
The previous ASM software version will be overwritten on the directory where the ASM Server
was installed. You must uninstall the existing ASM software before you can install the new
software in another directory. See Appendix C for more information about the uninstall process.

6. The Installation Components dialog box appears. Specify which components you want to
install. The ASM Installation Wizard only installs the components you selected.

7. TheReady to Install dialog box appears which provides a summary of the installation settings.
Check the entered settings carefully.

8. Click Install to copy the ASM software in the specified directory on the selected computer.
9. Click Finish to complete the ASM server installation.

Updating an ASM server installation
If you want to update a previous ASM installation, a number of limitations apply.

On UNIX
To avoid writing permission errors in the directory where ASM was already installed, permit the user
who performed the initial ASM Server installation to run the update.

In addition, set all the files of ASM, as described in the table in Installing the ASM Server (p. 9) ," with
an overview of all ASM files, under <home directory>\bin and <home directory>\lib to writable. This
procedure enables you to prevent installation problems.

On Windows
You cannot install more than one ASM Server on Windows. During an update of a previous ASM Server
installation, you cannot choose a target directory. The directory that was used for the first ASM Server
installation will be reused. This directory overwrites the existing binaries and DLLs.

Note that the configuration files will not be overwritten or removed. To install ASM in a different directory,
you must first uninstall the ASM Server. For more information, see Remove ASM software (p. 35) in
this document.

If a newer version of ASM is shipped with an updated Asm.msc file, the existing Asm.msc file will be
renamed to the Asm.sav.msc.
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Caution

Stop ASM before upgrading. No ASM snap-in (Windows) must be in use in any MMC console. To stop
ASM will result in:

▪ Stopping automatic instances.
▪ Lose information of running processes.

An update to 64-bit ASM is supported if a 32-bit version of ASM was already installed (all versions prior
to ASM 1.7 were 32-bit), however, some restrictions apply:

▪ If ASM Server was installed and was configured with customized start-up arguments (for
example; specifying a non-default listening port), then these arguments are lost upon update
from 32-bit to 64-bit ASM.

▪ Customization of startup arguments is still possible:

▪ Temporary:

▪ Open the service control manager (from Windows, Start->Administrative
Tools->Services).

▪ Open the property page of the Infor ES Application Service Manager and pass the
required arguments in the Start parameters field.

▪ These parameters become active if the service is restarted. These parameters get
lost upon closure of this dialog and/or upon reboot of the system.

▪ Permanent:

▪ Open a CMD window with administrator privileges (run as administrator).
▪ Move to the <home directory>\bin
▪ Stop ASM ( asm_srv -stop)

▪ Re-install ASM with the required arguments: for example asm_srv -install -p
8000
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This chapter describes the setup and use of the ASM server.

Starting the ASM server
After you have installed the ASM server, you must configure the server. To be able to configure the
server, you must start the server. This section describes the procedure to start the ASM Server.

The method to start an ASM server on a UNIX differs from a Windows computer. Some elements are
common, while others are platform specific.

The ASM server runs as a daemon on UNIX and as a service on Windows.

The server is represented by one single executable file called asm_srv.

Note that:

▪ To run the ASM server on a UNIX platform, you must have a root or super user authorization.
Ensure that only authorized personal can run the ASM server or configure ASM.

▪ In all cases, including for Windows, UNIX, the -home <home directory > argument is mandatory.
For Windows, the installer will create this argument for you at default.

Running the server on UNIX
By default, the server runs as a daemon process. The asm_srv command starts a server that listens
to incoming commands on the specified port. You can assign a port number by the p parameter. If this
number is omitted, the server uses the default port 7250. With the h, or ? argument, you can display
Help information.

You can specify these parameters in the asm_srv command on UNIX:

Infor ES Application Service Manager | Administration Guide | 15
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Enable inherit of the system environment variables that were set when the ASM
server was started.

-inherit

Stop server process (on UNIX)-k

Debug info (verbose output) for daemon asm_srv to stdout.-d

Override default TCP/IP listening port.-p <port number>

Set program home directory for ASM Server. This option is mandatory.-home <home direct-
ory>

Refresh interval for which ASM scans the existence of the process for instances
with Running status. Minimum refresh time is 10 seconds. Default refresh time
is 30 seconds.

-r <time in seconds>

Display help/usage information-? or -h[elp]

Version information-v

Starting a server that uses the default port 7250 run this command:

# asm_srv -home <home directory>

or use the rc.startasm script in the <home directory>/etc directory.

To start an ASM Server that listens on port 7252 and inheriting environment variables of current process
run:

# asm_svr -home <home directory> -p 7252 -inherit

or use the rc.stopasm script in the <home directory>/etc directory.

To stop the server, you can simply stop the daemon. Do not forget to add the port number parameter if
the server does not use the default port:

# asm_srv -home <home directory> -p 7252 -k

Ensure that you start the server with the correct installation directory, provided in the -home <home
directory > argument.

The first time you start the ASM Server:

# ./asm_srv -home <home directory>

This message appears:

" asm_srv: ASM daemon failed to read/open/parse configuration files. Please refer to previousmessages."

You can ignore this message. To verify if the server is running, use this command:
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# ps -ef | grep asm_srv

root 10598 1 0 Jan 7 ? 0:00 /home/bw/root/asm/bin/asm_srv -home /home/bw/
root/asm -p 7250

root 13944 1 0 Jan 2 ? 0:00 /home/root/bin/asm_srv -home /home/root -d

root 26663 1 0 11:26:27 ? 0:00 ./asm_srv -home <home directory> -p 7252

Running the server on Windows
At default, the installer configures the ASM Server. The ASM Server is installed as a Windows service.
The ASMService Manager is automatically started when a system is rebooted. To stop the ASM Service
Manager, you can use the Microsoft Windows Service Manager.

The manual configuration of ASM Server on Windows is only required in these instances:

▪ You want to run ASM Server from a different port number.

▪ You must run ASM Server in debug mode for verbose output.

In these cases, you must start and configure ASM Server from the command line.

Starting the server on Windows
To start the ASM server, use the Windows service manager:

Click Start > All Programs > Control Panel Administrative Tools > Services > Infor ES Application Service
Manager.

Manual startup of the server on Windows
For settings other than the defaults, such as occasional maintenance, and in case of, for example,
troubleshooting, you must use different command line options. You must start the ASM Server once
from the command line, rather than use the Services Manager. After you start the ASM Server once
with the required arguments, the arguments will be remembered the next time you start the ASM Server,
either by command line with (only) the -start argument, or by the service manager.

This table lists the available command line options:

Enable inherit of the system environment variables that were set when the
ASM server was started.

-inherit

Start asm srv service (if installed)-start
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Stop asm srv service (if installed)-stop

Install asm srv service-install

Remove asm srv service-remove

Override default TCP/IP listening port.-p[ort] <port number>

Set program home directory for ASM Server. This option is mandatory.-home <home directory>

Refresh interval for which ASM scans the existence of the process for instances
with Running status. Minimum refresh time is 10 seconds. Default refresh time
is 30 seconds.

-r <time in seconds>

Display help/usage information-?, -h[elp]

Debug info (verbose output) for daemon ‘ asm_srv’ written to (typically)
%windir%\temp\asm_srv.log.

-d

Version information-v

To change the -home parameter, you must stop the ASM Server. Change the -home parameter and
restart the server with this new -home parameter.

▪ If no additional arguments are provided to the start-stop or install command, the arguments
of a previous call will be used. If the arguments were provided once, these arguments are
used after a reboot or by means of the Control Panel, or if manual, these arguments are used
from the command line.

▪ If you use the -d option, additional events are written in the Event Viewer, for example, the
location of the debug file is also shown in the Event Viewer. Check the events in the Event
Viewer when the ASM Server is started with the -d argument.
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This chapter describes the installation process and the use of the ASM configuration tools.

Using the ASM MMC snap-ins
Snap-ins are the individual management components loaded into the MMC as tools to help you perform
administration tasks. These ASM snap-ins are available for the MMC:

▪ ASMCfg snap-in: With this snap-in you configure instances and services. This snap-in requires
a manual installation.

▪ ASM Snap-in: With this snap-in, you can monitor, start, or stop the instances. This snap-in
requires a manual installation.

Both snap-ins are implemented as an MMC snap-in and use the Microsoft Management Console. Note
that the interface can look slightly different for different MMC versions.

Prerequisites for ASM MMC snap-ins

The user can only perform the installation of the ASM UI snap-in on the client computers if these system
requirements are met:

▪ A supported Windows version is used, see appendix E.
▪ MMC version 3.0 or later installed locally.

In addition, if you want to actually use the snap-in, the ASM Server must also be available, either locally
or on a remote computer.

LN snap-ins for MMC
Before you can use an ASM snap-in, you must save the MMC with ASM snap-in to a MMC console file
(optional).
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To start the MMC console you must double-click the Asm.msc file. By default, you can find this file in
the directory: < home directory > \bin\ asm.msc

To save your MMC with added ASM snap-ins, on the Console menu, click File > Save or Save As … to
save your console as an MMC console file with the extension .msc. This enables you to use the console
in the future.

If you save the snap-in settings, Windows saves the settings by default in the directory Start Menu\
Programs\Administrative Tools of the client-user. In that case, to start the snap-in, you must
choose the snap-in from the Administrative Tools on the Start menu.

An error is displayed in the right pane of the snap-in if the ASM snap-in DLLs are 32-bit, and the used
Windows version is 64-bit. It is recommended to move to a 64-bit version of the snap-in.
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This chapter describes how to configure the ASM server.

Configuring services and instances
After the installation, you must configure the ASM server so you can use ASM to start or stop services
or sessions. To create services or sessions, you must use UI-based utilities on a Windows system. The
user interface of Application Service Management (Manager UI) consists of a graphical ASM snap-in
that runs on the Microsoft Management Console (MMC).

Overview
With the ASM Cfg snap-in, you can manage the data related to servers and some configuration settings
of the ASM, such as the servers that are currently in use.

The snap-in uses a two-pane view that is similar to the Windows Explorer. The console tree is used for
navigation and selection and represents the hierarchical structure in which the data are stored. This tree
appears in the left pane, which is called the Scope pane. The Detail or List pane on the right shows
the content of what you select in the Scope pane.

The console tree contains nodes and items. Nodes are composite and consist of other nodes or items.
You can compare nodes to the folders in the Windows Explorer.

Items are simple components at the lowest level of the console tree, which do not contain other elements.
Items are similar to the files in the Windows Explorer.

Items are only visible in the Detail pane. All items have properties or attributes that are displayed as
columns in the detail pane. To adjust the column width, you can drag the margins of a column with the
mouse. To sort a column, you can click the column’s header, and on the View menu, click Choose
Columns to pick the properties that you want to see.
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Action menu

The Action menu contains a number of commands for the nodes and items in the console tree. The
commands that are available on themenu depend on what you select. The same commands are available
in the shortcut menu that appears if you right-click the node.

Nodes can also have properties, although not necessarily. Both items and nodes can have tasks and
various other features.

Configuring the ASM Server
Use AsmCfg Snapin to create specific services. With the ASM Snapin, you can stop or start these
services.

To configure the ASM Server:

1. Log off and return to the MMC console. To configure your snap-in, right-clickAsmCfg Snapin.
2. On the shortcut menu, point to New and click New Host. You can also click Action from the

menu and make the same selection.
3. The Create a New Host dialog box appears. Specify the host and click Create.
4. Specify this information in the fields of the Specify Connection Data dialog box:

▪ Host name: Specify the name of the server which applications you want to control with
the ASM.

▪ Port number: Specify the port number on which the server’ s ASM receives commands.
The search path determines the server’ s ASM port number:

▪ The port number you specify at start up of the ASM.

▪ If you do not specify a port number at startup, ASM uses the port number defined for
the logical name BaanASM, in the file etc/services.

▪ If no port number is specified, ASM uses the default port number 7250.
If the value you enter in this field does not correspond to the server’s ASM port number,
the MMC cannot command the server’s ASM.

▪ Time out value(s): Specify the MMC’s timeout value, in seconds, for communication with
the ASM daemon. The default value is thirty seconds. For wide area networks, or if your
ASM runs on a heavily loaded server, you must increase this value.

5. Click OK.
6. Open the service types of the host you just configured. On the right pane, these types appear:

▪ Generic service types: Usable for every environment.

▪ Specific service types: Limited to a single environment.
7. Right click Generic Service Types, and on the shortcut menu that appears, point to New,

and click New Service Type to create a service type:
8. Enter a service type and click Create. The Specify Type Properties dialog box appears:
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In this example, a service will be created to stop and start the printer daemon.

9. Specify a Type Name and click the Start Attributes tab.
Specify the executable that starts an LN application service, for example, a command to start
the printer daemon.

The name of the executable that starts the application service,
for example, the command to start the printer daemon, ${BSE}/
bin/pdaemon6.2

Executable
Name

The service or session starts with the parameters you specify
here. You can also leave this field empty.

Executable Para-
meters

Enter the session code of the session that the ASM must start.
For example, the Activate Job Daemon (ttaad5206m000) session,
to start the job daemon.

Session Code

Overrules the default start parameters. The service or session
will be started with the parameters you specify here. You can
also leave this field empty.

SessionParamet-
ers

10. Click the Stop Attributes tab.
Specify this information:

The name of the executable that stops the application service,
for example, the command to stop the printer daemon, ${BSE}/
bin/pdaemon6.2

Executable
Name

The service or session stops with the parameters you fill in here.
You can also leave this field empty. To stop the printer daemon
specify -k.

Executable Para-
meters

Enter the session code of the session that the ASM must start to
stop.

Session Code

Overrules the default stop parameters. You can also leave this
field empty.

SessionParamet-
ers

11. Click OK to return to the MMC console.
The specific service types are limited to a single environment and have precedence over
generic service types if both exist with the same name. You do not have to specify the Stop
Attributes.
You have now predefined in XML files the application services that the ASM can start, and in
some cases, stop. The services that you defined to be started, and for unique instances only,
stopped by the ASM, are called instances. To be able to work with the services, you must
configure the service instances.

12. Right-click Service Instances.
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13. On the shortcut menu that appears, point to New, and click New Service Instance Host.
14. Enter a service instance and click Create. The Specify Host Properties dialog box appears.
15. Fill in the host name where you want to stop or start the service and click OK.
16. Right-click the Host Name you just specified, and on the shortcut menu that appears, point

to New, and click New Environment.
17. On the Create a new Environment dialog box, specify the directory of the new environment,

and click Create

18. On the Specify Environment Name and Directory dialog box, specify the environment Name
and the correct path name to the LN environment where you want the service type to start.
This name appears in the left pane of the MMC console.

19. Right-click the environment you just created, and on the shortcut menu that appears, point to
New, and click New Service Instance.

20. Specify the name and click Create. The Specify Instance Properties screen appears.

21. On the Service Instance Properties tab, specify this information:

Specify the appropriate instance nameInstance Name

Select a service type.Service Type

Select the Multiple occurrence, when you can have multiple oc-
currences of the instance’ s application service running at the

Occurrence
(Multiple)

same time. The ASM can start a multiple occurring instance’ s
application service when requested by a user of an external
softwaremodule. The user, and not the ASM, stops the application
service using the external software module. To communicate
back to the ASM server, Multiple instances must have an integra-
tion with ASM.

Select the Unique occurrence, when you can only run one occur-
rence of the instance’ s application service at a time. You can

Occurrence
(Unique)

use the ASM to start or stop a unique occurring instance’ s applic-
ation service. For example, the ASM can start and stop a job
daemon.

Note that If you use the ASM to start and stop a job daemon in a BSE, you must stop and
disable the Infor manager’s control of the job daemon service in that BSE.

When you start the ASM, the ASM automatically starts the in-
stance’s application service. You can still manually command the
ASM to stop and restart the instance’s application service.

Startup (Auto-
matic)

When a user sends the start command to the ASM, the instance’s
application service starts.

Startup (Manual)
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Specify the OS name of the user to whom the system registers
the instance’s application service, when started by the ASM. If

User Name

this user name is not a valid user name on the system, the ASM
will not start the application service.

Enter the OS password of the user that you entered in the User
Name field. If the password is not valid, the ASM will not start the

Password

application service. Ensure to update this field whenever the OS
password changes.

Re-enter the OS password of the user that you entered in the
User Name field.

Retype Pass-
word

22. On the Start Attribute and Stop Attribute tabs, specify the fields to your requirements. Steps
9 and 10 list the descriptions of the tab’s fields.

23. Click OK. The instance is created and appears on screen.
To check the data before you send the data directly to the server, you can use the consistency
check. In this case, you can test the data and decide whether or not to save the data to the
server.
Otherwise the server content is always refreshed without testing. On the shortcut menu that
appears, point to All Tasks and click Verify Consistancy.
If you decide to save the data to the server, choose to save all your settings. Select the host
name and right-click on the mouse. On the shortcut menu that appears, point to All Tasks
and click Save Service Types and Instances to ASM Server.
After you change the configuration settings, you must always restart your ASM Server to let
the changes take effect. You can stop and restart the server on UNIX with the rc.stopasm and
rc.startasm scirpts.
You can also use these commands:
# <home directory>/bin/asm_srv -home <home directory> -k

# <home directory>/bin/asm_srv -home <home directory>

On Windows, you can restart the ASM Service with Microsoft’s Services Manager. Click Start
> All Programs > Control panel > Administrative Tools > Services . For more information, see
Chapter " Start the ASM Server."

ASM in combination with the LN installation
During an installation of LN together with the ASM software in one run, the Job Daemon will be configured
automatically.

To modify these automatically configured files:

1. Start the ASM snap-in (asm.msc) and define the host in the AsmCfg Snap-in.
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2. To configure your snap-in, right-click AsmCfg Snapin. On the shortcut menu that appears,
point to New and click New Host.
You can also click Action from the shortcut menu and make the same selection. The Create
a New Host dialog box displays.

3. Enter the host and click Create. The Specify Connection Data dialog box appears.
4. Check the Port Number and Time Out Value (for example 7250 and 10).
5. Click OK to complete the insert action.

The AsmCfg Snapin is configured with the jobdaemon information.
You must now follow the same procedure for the Asm Snapin. After the configuration, you
can use the jobdaemon service.
Proceed with chapter, " Starting and stopping services" .

26 | Infor ES Application Service Manager | Administration Guide

Configuring ASM



This chapter describes how you can use the ASM to start and stop ( LN) application services.

Starting and stopping services
The ASM server is an administrative tool that you can use to start, and in some cases, stop LN application
services.

For example, the ASM can:

▪ Start and stop the job daemon: You can perform these steps either by UI, using the MMC
snap-in called ASM snap-in, or from the command line with the Asm_cli utility, as described
in Management from command line (p. 31) in this document.
You configured your MMC’s ASM snap-in. To command the host’s ASM to start or stop unique
instances, take these steps:

▪ Host:
In the Details pane, or in the Tree pane, right-click a host, or select the host, and click the
Action menu. Point to All Tasks, and on the sub-menu click:

▪ Start: To start all of the host’ s unique stopped instances.

▪ Stop: To stop all of the host’ s unique running instances.

▪ BSE:
In the Details pane, or the Tree pane, right click on a BSE, or select the BSE, and click the
Action menu. Point to All Tasks, and on the sub-menu click:

▪ Start: To start all unique stopped instances of the BSE.

▪ Stop: To stop all unique running instances of the BSE.

▪ Instance:
In the Details pane, or the Tree pane, right-click on an instance, or select the instance and
click the Action menu. Point to All Tasks and on the sub-menu, click:

▪ Start: To start a stopped instance.
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▪ Stop: To stop a running instance.

Note

▪ You cannot start or stop multiple instances with the MMC. You can only view the ASM ’s
multiple instances with the status Defined.

▪ Stopping ASM will lose information about all running processes.

Various statuses of the Asm Snapin

For multiple instances:

▪ Stopped
▪ Defined

The status Defined signifies that a minimum of one multiple instance is started. However, this does not
imply that this multiple instance is also still running, because an ASM client, such as OpenWorldX, itself
will trigger a multiple instance when to stop. The ASM server has nothing to do with this process.

For unique instances:

▪ Stopped
▪ Running
▪ Unknown

The status Unknown signifies that the ASM server starts a unique instance and the start/stop command
that belongs to this instance finished the execution. This occurs if the unique instance runs another
command or forks itself to a background process with another process ID. The ASM server can no longer
find the process ID of the start/stop command. To prevent the ASM server from showing instances with
status Unknown, you must use commands that will continue to run as a foreground process after being
started. An example of a process that forks itself to the background, and as a result, receives the Unknown
status after being started, is the LN printer daemon. Do not start this daemon from
${BSE}/etc/rc.start_pdaemon.

At default ASM will scan its running processing each 30 seconds. If a process was stopped, without
ASM got a stop request, the process is being marked with Unknown status.
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This appendix describes how to deal with error messages and other issues that can occur during the
installation or configuration of ASM.

Messages
The ASM Server creates messages due to configuration mistakes.

Error -2

▪ The BSE environment (path) is unknown.

▪ The instance is not found for the entered environment.

Error -4

▪ Incorrect path to executable for start command.

▪ Authentication failure (no permission to start).

Error -6

▪ Incorrect path to executable for stop command.

▪ Authentication failure (no permission to stop).

Error -8

▪ The ASM Server is not running. No connection was possible from a client.

▪ The ASM Server was running, but on a port number other than the port the client uses.
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Not all possible causes for errors can be described here. In case of errors, for more information, see
the log files for UNIX, or check the Event Viewer for Windows. More detailed information appears if you
start the ASM Server in debug mode

To debug ASM Server
In case of problems, you can see additional information when the -d argument is used.

For Windows, the debug information is logged in %windir%\temp\asm_srv.log. The name of the debug
file appears in the Event Viewer.

For UNIX, the debug information is written to the console (stdout).

To start the server in debug mode on UNIX, type this command:

# asm_srv -d -home <home directory>

On Windows:

# asm_srv -start -d -home <home directory>
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This appendix describes the use of the command line. With a command prompt, you can send commands
to ASM through a command line interface.

Management from command line
Start, stop, and view the uniquely occurring instances defined for the ASM in any of your domain’s BSEs.

View the multiple occurring instances defined for a host.

The following table lists the commands for the command line.
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Additional Optional Com-
mands

Additional Mandatory Com-
mands

ActionCommand

-h hostList all instances defined
for the ASM

-l

-p port

-h host-i instance_nameStarts your selected in-
stance.

-start

-p port-e env.directory

-u user_name

-p pwd password

-h host-i instance_nameStops your selected in-
stance

-stop

-p port-e env.directory

-u user_name

-p pwd password

-h host-e env.directoryStarts all the BSE’s
unique instances

-start_all

-p port

-h hostStops all the BSE’s
unique instances

-stop_all

-p port

Displays the version in-
formation for the asm_cli
binary

-v | -V

Displays help for the
asm_cli binary

-help

Enter the appropriate command for your platform:

▪ On UNIX: asm_cli
▪ On Windows: asm_cli.exe

Do not start instances of the type ‘multiple’ from the command line, which is uncommon. This type of
instance expects to be able to talk back to another application. If this type of talk back application is
unavailable, the started multiple instance will not respond. In general, external applications start multiple
instances. These external applications know how to communicate with such kind of instance.
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Any user with a command prompt can send commands to the command line interfaces of the ASM s in
their domain. For every server in your domain that has a BSE, you must restrict the access, and
executable permissions in the directory ${BSE}/bin, to trusted users.
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This appendix describes the procedures to remove the software. First, this appendix describes how to
uninstall the server. Subsequently, this appendix describes how to uninstall the ASM MMC snap-ins.

Remove ASM software

Uninstalling the ASM Server
In case of an installation failure or a change to the installation directory, you must take these steps to
uninstall the ASM Server:

On UNIX

▪ Stop the ASM Server and remove all ASM components manually. See Installation of the ASM
Server for the list of files belonging to ASM.

On Windows

▪ Stop the ASM Server and run the CMD window as administrator. Change to the directory
where the ASM Server was installed. The server will be stopped and removed with these
commands:
cd <home directory>/bin

asm_srv -remove

Before you can remove the bin\AsmCfgSnapin.dll and bin\AsmSnapin.dll files, you must first
run these commands:
regsvr32 /u <home directory>\bin\AsmCfgSnapin.dll

regsvr32 /u <home directory>\bin\AsmSnapin.dll

Remove all remaining ASM components. See Installation of the ASM Server for the list of files
belonging to ASM.
Note that the directory where ASM is installed (<home directory>), will likely contain more
data, such as, for example, files for the Solution License Manager. Be very careful when you

Infor ES Application Service Manager | Administration Guide | 35

C
Appendix C
Remove ASM



delete files in this directory. For more information, see the table in Installation of the ASM
Server, “Installation of the ASM Server,” for a complete list of files for each platform
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This appendix describes why and how to set environment variables.

Environment variables
In some specific cases, you must specify environment variables for the ASM server. These variables
are required in these cases:

▪ An instance started by the ASM server can require an environment variable. An environment
variable can be set system wide. This means that all LN environments installed on the system,
and use the same environment variable are forced to use the same (value for this) variable.
For example, a bshell must load a shared library for a third-party product, such as the database
driver. In this case youmust set the appropriate environment variables. On aWindows platform,
you must set the environment variable as a system environment variable. A user environment
variable will not be recognized by ASM. If you have set a system wide environment variable,
you must reboot your system to activate the variable. Any subsequent process that is started
by an ASM instance is assumed to be accessible by the PATH variable if not qualified with a
full path name. At default, the ASM instances do not inherit system environment variables (of
the user that starts the ASM server). You must use the -inherit flag to inherit system/service
environment variables by ASM instances.

▪ On Windows, the ASM Server runs in the context, and with the same environment, in which
the server was started. As a result, for Windows, the ASM Server runs in system context, and
only has the variables of that specific system environment.

▪ On UNIX, no environment variables are defined if the ASM Server was started from, for
example, boot time. Environment variables are only available on UNIX as soon as you start
to work from a shell, such as korn shell/bourne shell, and so on. To overcome these problems,
start the ASM Server from a shell with the correct environment variables defined. Remember
that the shell may affect argument passing. Use for ksh for example; " $@" (with quotes)
instead of $*. Check manual page of ksh for more information.

▪ If it is not desirable to use a system wide set environment variable, you must use a shell script
or batch file to set the variable. For LN Environments, you can also set variables per LN
environment with the Infor ES management snap-in.
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Example: Set your environment variables

Set your library variable on the server if you use theWeb UI framework to connect to the LN environment
and you use the Java Development Kit or Java Runtime Environment. On an AIX machine, the variable
is the LIBPATH variable. On all other UNIX systems, the variable is called the LD_LIBRARY_PATH
variable. The operating system dependent variable must be set using a shell, for example, korn shell,
before the ASM Server is started.

Note

All environment variables defined at startup of the ASMServer are system-wide settings. These variables
are valid for all instances and types defined. To set environment variables, which are only required for
one instance, the application, or shell scripts for UNIX only, must take care of the application’ s own
environment variables. In LN you can use the Infor ESManager snap-in to set the environment variables.
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See for the support matrix, support Java versions and Virtualization support the last version of the Infor
Enterprise Server Support Matrix for porting set (U9757). The last version of this document can be found
in KB 1183466 at http://www.infor.com/Inforxtreme .

32-bit Windows is not supported anymore starting with ASM 1.7
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Starting the tmboaserver through ASM
If you want to start and stop the tmboaserver with ASM, you can use this section to specify the correct
information. To create a new Service type and Service Instance you can follow the procedure as described
in Configuring the ASM Server (p. 22) .

The sessions which are used most to start are:

Multiple occurrence (runs forever unless killed):

▪ tmboaasmserver

Unique occurrence:

▪ job daemon (ttaad5206m000/ttaad5207m000) (with start and stop function)

▪ job (ttaad5203m000) (only with start function)
▪ tmboaserver (with start and stop function)

This table contains the information for the tmboaserver:
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Service Type properties tab specify the name tmboaserver

On the Start Attributes tab

${BSE}/bin/bshell6.2Executable Name

-serverExecutable Parameters

tmboaserverSession Code

-dSession Parameters

On the Stop Attributes tab

/usr/bin/javaExecutable Name

-Xrs -cp ${BSE}/java/ow.jar:${BSE}/java/
ow3p.jar:${BSE}/java

Executable Parameters

com.baan.owtools.BackendControlSession Code

-dSession Parameters

This table contains the information for the server instance:
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Service Instance Properties

Specify the appropriate instance nameInstance Name

tmboaserverService Type

UniqueOccurrence

ManualStartup

bspUser Name

Enter the OS password of the user that you
entered in the User Name field

Password

On the Start Attributes tab

Do not selectOverrule Executable Parameter

-dbgjvmiExtra Executable Parameter

Do not selectOverrule Session Parameter

-busc <Buscomponent> -l log.tmboa -sExtra Session Parameter

On the Stop Attributes tab

Do not selectOverrule Executable Parameter

Do not selectExtra Executable Parameter

Do not selectOverrule Session Parameter

-busc <Buscomponent> -action deactivateExtra Session Parameter
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